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PROGRAMMING GUIDE
Universal Dragon 2.3
PROGRAMMING SOFTWARE



2 UNIVERSAL DRAGON 2.3

INTRODUCTION
Universal Dragon is powerful software for programming Xantech programmable devices. Universal Dragon features a
graphical interface with drag-and-drop capability that makes it easy to program a device with anything from basic functions
all the way up to sophisticated macros involving many different commands that control multiple components. 

Universal Dragon v2.3 offers dramatic improvements over previous versions that make the power of all Xantech
products much more accessible to dealers and programmers, even those with little or no experience using software
to configure sophisticated control and distribution devices and systems. New features integrated in to the Universal
Dragon v2.3 release are as follows:

• New project creation is easier than ever before. The AutoBuild Wizard makes it possible to build an SPLCD or
XTR39 project through a menu-driven process and have a complete working project within minutes. 

• Use AutoFill to drag an entire group of commands from the palette editor onto your SPLCD/XTR39 project page 

• Import/Export SPLCD/XTR39 individual al pages 

• You can now resize the look of your base unit 

• Rewritten Palette Editor now uses a relational database instead of an XML file 

• Default template support for different base units 

• HEX-IR support for XTR39, SPLCD, MRC44/88 

• Source overview window for SPLCD and XTR39 projects 

• You can now mix graphic styles on an XTR39/SPLCD 39G/57G project (previously you were limited to using only
one graphic style).

COMPUTER REQUIREMENTS
Operating system: Windows XP or Vista with Microsoft.NET framework

Processor (CPU) capability: 1.0GHz or greater (1.5GHz preferred)

Free hard drive space: Minimum of 800MB (as your libraries and projects expand you will need more)

RAM: Minimum of 512MB (1GB is preferred)

Hardware: Mouse (or laptop touchpad), keyboard, USB port or com port or USB-to-Serial adapter

PROGRAMMING INTERFACE
When you first launch the Universal Dragon software, the programming window appears, with no device selected (see
Figure 1). To begin programming you must first select the device you want to program:

1. Go to the File menu and select New Project.  The New Project window appears (see Figure 2).

2. Select the device you want to program from the drop-down list. The device will appear in the middle of the 
programming window (see Figure 3, on page 3).

IMPORTANT: IF USING WINDOWS VISTA, THE FIRST TIME YOU LAUNCH UNIVERSAL DRAGON YOU MUST RIGHT-CLICK ON THE

UNIVERSAL DRAGON DESKTOP ICON AND SELECT RUN AS ADMINISTRATOR.

Figure 1: Programming window (no device selected) Figure 2: New Project window
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UNIVERSAL  DRAGON 2.3

PROGRAMMING WINDOW FEATURES (see Figure 3)

NOTE: THE FEATURES SHOWN HERE ARE COMMON TO MOST DEVICES. DIFFERENT XANTECH DEVICES HAVE DIFFERENT

FEATURES AVAILABLE IN THE PROGRAMMING WINDOW. THESE WILL BE DISCUSSED IN THE BASE-UNIT SPECIFIC

EXAMPLES SECTION THAT BEGINS ON PAGE 6.

TOOLBAR: Contains icons for basic Universal Dragon program functions

TIER SELECTOR: Selects the button action (press-and-release or press-and-hold) being programmed.

DEVICE BEING PROGRAMMED: After selecting a device in the New Project window, it will appear in the center of the
Programming Window. Smartpad and Waterpad devices also provide a drop-down list for selecting 
specific modules.

MACRO WINDOW: Shows all of the commands and delays that have been programmed into the selected button.

SELECTED BUTTON: The button currently being programmed is highlighted in blue.

COMMAND LIST/GRAPHICS PALETTE SELECTOR TABS: When the Graphics Palette tab is selected the Macro Window
changes function to show all of the available graphics elements if the device being programmed has graphics
capability.

PALETTE EDITOR TOOLBAR: Contains icons for Palette Editor functions.

LIST OF CONTROLLABLE COMPONENTS: Displays a list of components that can be controlled by the selected device.
Selecting a brand displays all of its controllable components; selecting a component displays the 
control method: 1 (IR), RS232, or Hex.

COMMAND LIST WINDOW: After selecting a control method above, the Command List Window displays all of the
available commands for the selected component.

SELECTED COMMAND: Selecting a command programs its function into the selected button.

PROGRAMMING WINDOW FUNCTION SELECTOR TABS: Switches the Programming Window’s function between Palette
Editor (shown), Internal Commands, RC68, X10 and Properties.

You can re-size the different sections of the Programming Window by clicking and dragging their borders.

Macro
Window

Selected
Button

Device Being
Programmed

Command List/
Graphics Palette

Selector Tabs

Programming Window
Function Selector Tabs

List of
Controllable
Components

Command
List Window

Toolbar

Smartpad/Waterpad
Key Module Selector 

Selected
Component

Palette Editor
Toolbar

Selected
Command

Code String for
Selected IR 
Command

Tier
Selector

Figure 3: Programming window features
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BASIC PROGRAMMING STEPS
The basic Universal Dragon programming steps are the same for all Xantech programmable devices. 

SELECT A DEVICE
1. Use File>New Project or New Project toolbar icon (Figure 4) to 

create a new project. Each controllable device must be pro-
grammed as a separate project. Universal Dragon makes it sim-
ple to use the programming for existing projects to program new
ones.

2. Select the device you want to program from the list.

3. The device will appear in middle of programming window.

BUILD MACROS
Devices are programmed using the Palette Editor. The Palette
Editor has two modes: PALETTE and EDIT, selectable by the Mode tab
(Figure 5).

PALETTE: Displays a list of components with commands that are
known to work with the selected device. 

EDIT: Displays a list of all brands and products with control data in
the system, even those that may not work with the selected
device. 

1. Select the component to be controlled from the list of controllable
components in the Palette Editor (see Figure 3, on page 3). 

a) Select a brand to display all of that brand’s controllable components. 

b) Select a component to display that component’s available control methods:

1 OR 2: IR codes

RS232: RS-232 codes

HEX: Published IR command data (such as typically used by Pronto remotes) for use creating new IR 
commands when the original IR remote is unavailable to learn from. A large selection of hex codes for many
remote controllers can be found at www.remotecentral.com.

c) Select a control method to display a list of available commands for the selected component.  

2. Select the device’s button that you want to program, and then click on the desired command. The command will
be applied to the button, and will appear in the Macro Window. (See Figure 3, on page 3)

NOTE: IR, RS232 AND HEX COMMANDS ARE ALL PROGRAMMED IN THE SAME WAY, ALTHOUGH HEX COMMANDS MUST BE

CREATED BY THE PROGRAMMER.

3. You can create a macro by programming a string of commands for a single component or multiple components to
a single button. Each time the button is pressed it will issue all
of the programmed commands, in the order they appear in the
Macro Window.

Inserting Delays in Macros

You can add delays between commands. (See Figure 6.)
Depending upon the particular components being controlled, this
can make a macro run more smoothly.

1. Select the delay amount. You can select from 0.1 to 30 
seconds.

2. Drag the Watch Icon into the Macro Window, between the com-
mands where you want the delay. The selected delay will appear
in the command string.

MODE TAB

Figure 5: Palette Editor Mode tab

NEW PROJECT ICON

Figure 4: New Project Icon

Figure 6: A one-second delay between commands

WATCH ICON DELAY AMOUNT SELECTOR
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UNIVERSAL DRAGON 2.3

Adding IR Repeats to Commands in Macros

Once a command has been added to a macro you can add IR repeats as necessary to enable the command to
work properly within the macro. See Figure 7.

1. In the Macro Window, click on the command you want to have IR repeated.

2. Click on the COMMAND tab. The selected command’s characteristics will show in the window below the Macro
Window.

3. Select REPEAT. You can highlight and change the number of IR repeats to anywhere from 0 to 30.

X10 Commands (see Figure 8)

You can also add commands for X10 control components to macros on any Xantech programmable device.

1. Click on the X10 commands tab.

2. Select the X10 module address, module type and function.

3. Select the button on the device to which you want to apply the X10 command.

4. Click on the Place button. The X10 command will appear in the Macro Window.

You can also create X10 scenes by right-clicking in the Scene window. Add the scenes to macros by selecting
Run Scene [XX] as the function you’re placing in the Macro Window.

Tier Programming

The MRC88 series, Smartpad 3 series, Waterpad, and URC2
keypads allow two different actions for each button: Press-and-
release, and press-and-hold. This lets you program two 
completely different macros for each button, one on each tier.
Use the Tier Selector (see Figure 9) to select the tier before 
programming the button’s macro.  See Tiers, on page 24 for more
details. 

Figure 7: Adding IR repeats to a macro command

SELECTED COMMAND

COMMAND TAB IR REPEATS X10 Commands
Tab

Place
Button

Selected Button

X10 Function
Selector

X10 Command
Inserted Into Macro

X10 Module
Address Selector

X10 Module
Type Selector

X10 Scene
Window

Figure 8: Adding an X10 command to a macro (URC2 shown)

Tier Selector

Figure 9: Tier Selector



BASE-UNIT SPECIFIC EXAMPLES
SMARTPAD 3 FAMILY KEYPADS (PM110, LM110, EM110)
Smartpad 3 Programming

After selecting the appro-
priate base module using
the New Project icon or
menu tab, use the Key
Module Selector(s) to
select the particular key-
pad modules you are
inserting into the base
module (see Figure 10). 

PROGRAMMING BUTTON

GRAPHICS: Before pro-
gramming macros,  you
should first use the
Graphics Pallete to
define the functions of
the Smartpad 3 keypad
buttons. Doing this first
will simplify macro 
programming.

1. Select the Graphics
Pallete tab. The Macro
Window will convert to
the Graphic palette win-
dow (see Figure 10).

2.  Select the desired 
button graphic and
drop it onto the keypad button (see Figure 10).

The various Smartpad 3 keypad modules include  a selection of buttons with common markings that allow you to
apply the selected graphics to the buttons themselves. Refer to the Smartpad 3 instruction manual for details.

PROGRAMMING MACROS: The keypad module macros in the Smartpad
3 family are programmed using the basic steps described on pages 
4 – 5.

INTERNAL COMMANDS: In the Smartpad 3 family, the Internal Command
tab allows you to define the function of each keypad’s Mute Relay.

Project Options

BANK TRACKING: The Smartpad 3 Project Options window (see
Figure 11) lets you assign a group code for the keypad, and indi-
vidual bank numbers to each of the project’s sources that will be
used during RC68 operation. When multiple keypads are being
used in a single zone, Bank Tracking allows them all to switch to
the active source whenever the source is changed on one of the
keypads, keeping all the keypads ‘in sync’.

6 UNIVERSAL DRAGON 2.3

Graphics Pallete
Selector Tab

Selected
Button Graphics

Graphics Applied
to Keypad Button

Keypad Module SelectorTier Selector

Figure 10: Smartpad 3 keypad programming screen (with MMD1 and CMD6 keypad modules), showing but-
ton graphic programming

Figure 11: Setting Bank Tracking in Smartpad 3 
keypads



BASE UNIT SPECIFIC EXAMPLES
WATERPAD

Use the Key Module Selector to select the particular Waterpad module you are
programming (see Figure 12).

PROGRAMMING BUTTON GRAPHICS: Before programming Waterpad macros, you
should first use the Graphics Pallete to define the functions of the Waterpad
keypad buttons. Doing this first will simplify macro programming.

1. Select the Graphics Pallete tab. The Macro Window will convert to the
Graphic palette window (see Figure 13).

2. The Sources tab lets you assign graphics to the dedicated source buttons on
the WPK-4, WPK-6 and WPK-8 Waterpads. The Functions tab lets you assign
graphics to the Waterpad function buttons.

3.  Select the desired button graphic and drop it onto the keypad button.

The Waterpad includes  a selection of 128 button icon labels that allow you to
apply the selected graphics to the buttons themselves. Refer to the Waterpad
instruction manual for details.

PROGRAMMING MACROS: The Waterpad keypads are then programmed using the basic
steps described on pages 4 – 5. Note that the WPK-4, WPK-6 and WPK-8 keypads
have dedicated source buttons (indicated by a gold dot in the upper-left corner).

NOTE: THERE ARE NO PROJECT OPTIONS OR INTERNAL COMMANDS AVAILABLE IN

THE WATERPAD KEYPADS.
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UNIVERSAL DRAGON 2.3

Key Module SelectorTier Selector

Figure 12: Waterpad programming screen (WPK-4 keypad shown)

Figure 13: Waterpad Button
Graphics palette



BASE-UNIT SPECIFIC EXAMPLES
SMARTPAD LCD FAMILY
Smartpad LCD controllers (SPLCD) offer an extreme degree of operational sophistication and flexibility. The SPLCD
programming screen begins as a blank screen workspace (see Figure 14).  Each of the system’s components will
need to have its own LCD control screen with its own particular set of control buttons. Normally, each of these control
screens would have to be  created from scratch, with each button selected and positioned individually — a very time-
consuming process. This process can be streamlined by using Universal Dragon’s AutoBuild Wizard (see below).

AutoBuild Wizard

Universal Dragon includes an AutoBuild Wizard (File > AudoBuild Wizard) that streamlines the process of creating
individual SPLCD component control screens (see Figure 15). AutoBuild Wizard creates complete component 
control screens (including some basic macros) in just a few steps. This can save you a great deal of programming
time, while still providing you with the ability to customize each screen for the customer’s specific desires and the
installation’s specific requirements.

SPLCD Touchscreen Creation and Programming

NOTE: THIS SECTION EXPLAINS THE BASICS OF SPLCD TOUCHSCREEN CREATION AND PROGRAMMING. FOR DETAILED

INFORMATION PLEASE SEE THE SMARTPAD LCD INSTALLATION & PROGRAMMING MANUAL.

After selecting the specific SPLCD controller unit with the New Project function (File > New Project > Keypads >
Smartpad LCD > [39g, 57g, 64g or 64v), an empty SPLCD screen workspace appears (see Figure 14). You can 
re-size this screen as necessary by dragging its lower right-hand corner.

SELECTING AND PROGRAMMING TOUCHSCREEN ELEMENTS: The SPLCD provides graphic elements for the touchscreen’s
background, and Graphical Touch Links (GTLs) that serve as source buttons, and function buttons.

1. Select the Graphics Pallete tab to activate the Graphic palette window (see Figure 16, on page 9).

2.  The Styles drop-down menu contains different sets of backgrounds and source, function and image buttons.

3. Select the desired background from any style and drop it into the empty SPLCD screen.

NOTE: YOU CAN ALSO USE IMPORTED .BMP AND .PNG FILES AS CUSTOM BACKGROUNDS. FOR DETAILS SEE THE SMARTPAD

LCD INSTALLATION & PROGRAMMING MANUAL.

4. Plan your control screens in three layers: home, source and function. You should place all Source buttons and any
Function buttons that will be used on all screens (such as for volume, mute, and power) on the home page.

NOTE: SPLCD PROJECTS MUST INCLUDE AT LEAST ONE SOURCE BUTTON.

5. Click the Home Layer icon (see Figure 14) to activate the home page. After clicking the Functions tab, select and
drop the desired home layer Function buttons to the screen. 

NOTE: TO HELP WITH POSITIONING ELEMENTS, THE SPLCD SCREEN WORKSPACE HAS AN ALIGNMENT GRID (ALONG WITH A

“SNAP-TO” FUNCTION) THAT CAN BE TURNED ON AND OFF. (SEE FIGURE 16.) EACH HAS A BORDER (SHOWN AND

HIDDEN BY THE SHOW BORDERS BUTTON) THAT SHOWS THE GTL PLACEMENT RELATIVE TO THE GRID. ONCE ALL GTLS ARE

IN PLACE YOU CAN CLICK ON THE LOCK GRAPHICS ICON TO PREVENT ACCIDENTAL MOVEMENT OF THE GTLS.
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Figure 14: The SPLCD screen workspace (empty) Figure 15: SPLCD DVD control screen created with AutoBuild Wizard



6. Build macros for these buttons as described in Build Macros, on page 4. These macros should be for the 
volume, mute, power and other functions that you want to be available on all screens.

7. Once you have programmed all of the home layer function buttons, select the Source Graphic Elements Tab
(see Figure 15). Drop the desired Source buttons (one for each device to be controlled) onto the home layer
(make sure that you’re on the home layer before adding each Source button). You can program their macros
(as described in Build Macros, on page 4) now, or at a later time. 

NOTE: YOU CAN COMBINE SOURCE BUTTONS, FUNCTION BUTTONS, AND BACKGROUNDS FROM ANY STYLES.

8. Once all of the Source buttons are in place, select one (it will change to red) and then select the Functions
Graphic Elements Tab (see Figure 16). Drop the desired Function buttons for that source component onto the
source’s screen. You can program each button’s macro (as described in Build Macros, on page 4) now, or at
a later time.

9. Repeat Step 8 for each Source button in the project.
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Home
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Selected
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Graphics Palette Tab SPLCD Screen Workspace Properties Tab

Figure 16: SPLCD touchscreen creation screen



CHANGING SPLCD BUTTON TEXT

NOTE: THIS SECTION EXPLAINS THE BASICS OF CHANGING SPLCD BUTTON TEXT. FOR DETAILED INFORMATION PLEASE SEE

THE SMARTPAD LCD INSTALLATION & PROGRAMMING MANUAL.

The SPLCD lets you create text on blank Source and Function buttons (buttons that have text cannot be edited). 
This lets you create customized buttons for sources and functions not included in the library by dragging and drop-
ping blank buttons on screens and then labeling them.

1. Click on the Properties tab. The Edit/Graphics window will appear (Figure 17), showing the currently-selected 
button. (If the home page is currently selected the Edit/Graphics window will be empty.)

2. Click the cursor in the Caption Window and type
the text you want to appear on the selected but-
ton. After typing the text, click the cursor outside
of the Caption Window and the text will appear in
the Button Example (see Figure 18). 

3. Use the Font Selector and Text Color Selector to
change the font style and size and text color of the
button text in the Button Example (see Figure 18).

3. When you’re finished formatting the text, click on
the Apply button. The text will be applied to the
selected button (see Figure 19).

BANK TRACKING: Each Source button can be assigned
a unique Bank number for bank tracking during RC68
operation (see Figure 18).

1. Click the cursor in the Bank Tracking Selector.2.
Use the drop-down list to select the Bank num-
ber.

3. Click on the Apply button to apply the Bank
Tracking number to the selected Source button.

NOTE: SEE PROJECT OPTIONS BANK TRACKING, ON

PAGE 6.
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Properties Tab

Edit/Graphics Window

Currently-Selected Button

Figure 17: The SPLCD Edit/Graphics window

DirecTV

DirecTV

Caption
Window

Button
Example

Font
Selector

Text Color
Selector

Apply
Button

Figure 18: Edit/Graphics window text tools

Selected Button with
New Text Applied

Bank Tracking
Selector

Apply
Button

Figure 19: New text applied to selected Source button;
Bank Tracking selector



Internal Commands

The SPLCD lets you insert the following internal commands into macros: Set Backlight ON/OFF, Set Line Status
(relay voltage) ON/OFF, Password Lock, Password Unlock, Password Digit (see Password, on page 13 for details),
and MRC88 Button Emulation.

To add an internal command to a
macro (see Figure 20):

1. Click on the Internal
Command tab.

2. Select the desired internal
command and state with the
Internal Command Selector.

3. Select the button on the
SPLCD workspace to which
you want to apply the macro
command.

4. Click on the Accept button.

The internal command will
appear in the Macro Window.

Project Options

NOTE: FOR A MORE DETAILED

DESCRIPTION OF SPLCD
PROJECT OPTIONS, PLEASE SEE

THE SMARTPAD LCD INSTALLATION

& PROGRAMMING MANUAL.

SETTINGS (see Figure 21)

DISPLAY ORIENTATION: Set to UP if the SPLCD screen will be at or higher than the user’s eye level; set to DOWN if
the SPLCD screen will be at or lower than the user's eye level.

NOTE: CHANGING THE VIEW ALSO ROTATES THE SPLCD SCREEN IMAGE

180°, SO WHEN CHANGING THE ORIENTATION, INSTALL THE SPLCD
ACCORDINGLY:

• UP VIEW = Install the SPLCD with its IR sensor on the right.

• DOWN VIEW = Install the SPLCD with its IR sensor on the left.

LINE INPUT ROLE: Selecting IN configures the Status terminal on the
rear of the SPLCD to receive a 5V ~ 30V trigger signal from an 
external device; selecting OUT configures the Status terminal as a
switchable 12V trigger terminal to control an external device.

LED: Checking the Track box causes the SPLCD status LED to track the
status of the SPLCD’s rear panel Status terminal. When a 
+5V ~ 30V DC voltage is present at the terminal the SPLCD’s Status LED
illuminates. When the voltage drops to 0 the LED extinguishes. The LED
works in conjunction with the Line Input Role setting (see above).

BACKLIGHT SETTINGS: Determines the amount of time the SPLCD back-
light remains ON after its display is last touched.

RC68 SYSTEM: Refers to the group of incoming IR codes that will 
trigger outgoing SPLCD RC68 code macros. The SPLCD default
System code group is C9. 
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Internal Commands TabAccept ButtonSelected Button

Internal Command SelectorInternal Command Inserted Into Macro

Figure 20: Adding an Internal Command to an SPLCD macro

Figure 21: SPLCD Project Options settings
screen



RC68 BANK TRACKING: When two or more SPLCDs are set to the same
Bank Tracking code, they will track source selections so that when the
source on one SPLCD is changed, other units sharing its Bank Tracking
code will automatically switch to that source control screen.

RS232 (see Figure 22) configures the SPLCD’s rear-panel serial control
port:

• To control multiple RS232 devices with a Xantech RS2321X8 router,
check Xantech’s RS232 Router Enabled.

• To have the RS2321X8 always return to the port selected by the Default
Router Port drop-down menu, check Router’s Default Port Enabled.

• To configure each router port’s RS232 protocol, select the port in the
Router Port drop-down menu, and select the appropriate Baud Rate,
Data Bits, Parity, and Stop Bits. Repeat this for each router port in use.

• If a Xantech RS232-controllable device is being controlled, select the
appropriate driver from the Driver drop-down menu when configuring the
router port the device is connected to.

• The Dictionary option in the Driver drop-down menu lets you create a window
for displaying information on the SPLCD screen that has been sent by a 2nd-
party RS232 device. For more information, please go to http://www.xan-
tech.com/ products/software/Data%20Dictionary. pdf.

MRC88 EMULATION: A SPLCD controller can be integrated into MRC88 audio
systems by configuring it for MRC88 emulation (see Figure 23). 
For connection information and complete programming details please see
the Smartpad LCD Installation & Programming Manual.

1. After creating all of the SPLCD’s control screen layouts (see pages 
8 – 11), select the MRC88 Emulation tab in the Project Options window.

2. If you’re using more than one keypad in a zone, use the Keypad
Address drop-down menu to assign each one its own keypad address.

3. In the Source Name section, enter the name of each source as it
appears in the MRC88 project. This assures that the MRC88 Status
function displays the proper source names.

12 UNIVERSAL DRAGON 2.3

Figure 22: SPLCD Project Options RS232
screen

Figure 23: SPLCD Project Options MRC88
Emulation screen



Programming the SPLCD for
MRC88 internal command 
functionality (see Figure 24):

1. In the SPLCD Programming
Window, select a Source but-
ton.2. Select the Internal
Commands tab.

2. In the Internal Command drop-
down menu, select MRC88
Button Emulation.

3. Select the desired MRC88 but-
ton function from the drop-
down menu.

4. Click on the Accept button. The
selected function command will
appear in the Macro Window.

5. Repeat Steps 3 – 5 for each
Source button on the SPLCD.
You can also repeat the proce-
dure for any SPLCD Function
button that emulates one of the
MRC88 keypad functions, such
as Stop, Play, Pause, etc.

PASSWORD (see Figure 25): You can establish a password to prevent
unauthorized operation of the SPLCD. When the SPLCD is in the
password lock mode, touching the screen will automatically display
a factory-programmed unlock screen. The SPLCD will remain locked
until the correct unlock code is entered into the unlock screen.  

1. Check the Enabled box in the Password Project Options screen to
activate the password function.

2. Use the Auto Lock Timeout drop-down window to determine the
period of SPLCD screen inactivity that will initiate the password
lock function. The range is 5 seconds to 30 minutes.

3. Use the Password (4-10 digits) window to set the password key.

You can also use the Password Lock internal command to create a
screen button that will place the SPLCD into the password lock
mode whenever it is pressed.  See Internal Commands, on page 11.

IMPORTANT: THE PASSWORD FUNCTION IS ONLY AVAILABLE

ON COMMERCIAL SPLCD UNITS. IF YOU TRANSFER SPLCD
PROGRAMMING THAT INCLUDES THE PASSWORD FUNCTION TO A NON-
COMMERCIAL SPLCD UNIT, THE PASSWORD FUNCTIONALITY WILL NOT BE

ACCEPTED.
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Internal Commands Tab

MRC88 Button
Function

Accept ButtonSelected Source Button

MRC88 Button Emulation
Selected

MRC88 Button Function
Inserted Into Macro

Figure 24: SPLCD MRC88 Button Emulation programming

Figure 25: SPLCD Project Options Password
screen
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BASE-UNIT SPECIFIC EXAMPLES
MRC88 FAMILY

Labeling Source Icons

Before programming macros, you should label each of the system’s source
icons that appear in the Controller LCD Panel (see Figure 26). 

1. Double-click the desired source icon. The MRC Icon Text window will appear
(see Figure 27).

2. Type a name/icon for the source (“DVD”, “iPOD”, etc.). The name/icon can
be up to four characters. The new name/icon will appear in the LCD Panel
(see Figure 28).

3. Repeat Steps 1 – 2 for each of the system’s source components.

Macro Programming

The MRC88 keypad macros are programmed using the basic steps described on
pages 4 – 5. Some MRC88 buttons are factory-programmed with default 
functions (indicated by “M” macro symbols). These default functions can be
added-to as required for the project, but they cannot be deleted.

ZONE SELECTOR: A single Universal Dragon MRC88 project will contain the 
programming for all of that MRC88 unit’s zones (up to 8). Each zone’s 
controller module can be programmed individually (except for source buttons
and icons) by using the Zone Selector (see Figure 26).

Keypad
Tab

RC68
Tab

Transport
Buttons

Zone
Selector

RS232
Tab

Source
Triggers

Tab

Power
Management

Tab

Icon
Editor
Tab

Controller
LCD Panel

Tier
Selector

Channel
Buttons

Source
Buttons

Status
Button

Volume
Buttons

Figure 26: MRC88m programming screen

Figure 27: MRC Icon Text window

Figure 28: LCD Panel with source
names/icons.
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VOLUME, TRANSPORT AND CHANNEL BUTTONS: The volume buttons control the volume of the MRC88’s built-in amplifier
for that zone without requiring macro programming. If needed for the project, they can also be programmed to
execute additional macro commands using the basic steps described on pages 4 – 5. 

The volume, transport and channel buttons (see Figure 26) can be programmed to execute different macros for
each of the system’s source components:

1. Select the desired source button.

2. Select the desired volume, transport or channel button and program its macro using the steps described on
pages 4 – 5. 

3. Repeat Steps 1 – 2 for each of the system’s source components.

If you want any of the volume, transport or channel buttons to execute the same macro no matter what source
is selected:

1. Right-click on the desired function button after you have completed programming its macro.

2. Select Punch (Zone) from the menu that appears.

3. Select Yes in the Punch System Level dialog box that appears. 

STATUS BUTTON: The controller’s Status button is used in combination with other controller buttons to display 
various aspects of the system’s status on the controller’s LCD display, and cannot be programmed to execute a
macro.

INTERNAL COMMANDS: You can insert an extensive variety of MRC88 internal commands into macros, including the
following: 

• Settings for the zone’s power, volume, balance, treble and bass, and muting.

• Settings for linking and unlinking zones enabled for dynamic linking (see Zone Linking, on page 17).

• Main Zone/Sub Zone settings for zones with sub zones.

• Commands for controlling a Sonance iPort® dock in the RS-232 control mode. (To control the iPort via IR, use
the Palette Editor to program the iPort, as described on pages 4 – 5.)

• RS-232 metadata commands for Xantech XIS100, XT1 and Sonance iPort docks. 

• Settings for ‘tweaking’ the system via RC68 (trim adjustments, max volume settings. page volume settings).
Note: These are installer-only functions and would almost never be included in an end-user accessible macro.
See Section 7 of the MRC88
Installation Instructions for more
information.

To add an internal command to a
macro (see Figure 29):

1. Click on the Internal Command tab.

2. Select the desired internal
command and state with the
Internal Command Selector.

3. Select the button on the
MRC88 workspace to which
you want to apply the macro
command.

4. Click on the Accept button.

The internal command will appear
in the Macro Window.

Internal Commands TabAccept ButtonSelected Button

Internal Command SelectorInternal Command Inserted Into Macro

Figure 29: Adding an internal command to an MRC88 macro



16 UNIVERSAL DRAGON 2.3

Copying Macro Programming to All Zones

Once you have completed macro programming for Zone
1, if all zones are to have the same programming you can
copy the Zone 1 programming to all zones.

1. With Zone 1 selected, right-click on any button.

2. Select Punch (System) from the menu that appears.

3. Select Yes in the Punch Zone Level dialog box that
appears.

Project Options: Controller (see Figure 30)

BACKLIGHT SETTINGS: Sets the amount of time the keypad
LCD panel and button backlight remains active after the
last button press.

IR ROUTING: When Routing Enable is selected, IR com-
mands are directed only to the emitter outputs specifical-
ly configured for the source selected in a zone, and not to
the other source emitter outputs. When Routing Enable is
de-selected, IR commands are directed to ALL emitter
outputs. Emitters configured as Common will always out-
put all IR commands.

EXPANDED SYSTEM: Select when two MRC88 units are
linked for expanded operation via their Expansion Ports.

ZONE AUDIO INPUT: Activates the MRC88’s rear-panel Zone Audio Inputs. When selected, each component connected
to an MRC88 Zone Audio Input becomes a dedicated Source 1 input for that zone. (Each zone has its own dedicated
Source 1 source.) If Zone Audio Input is selected on this Project Options screen, Source 1 will be inoperative for any
zone that does not have a source connected to its Zone Audio Input.

NOTE: THE ZONE AUDIO INPUTS ARE AUDIO-ONLY.

MODE OF OPERATION: Whole House Mode allows any zone to monitor and control any source. Priority Lockout Mode
activates the Monitor Lockout matrix, which prevents designated sources from being monitored and controlled in
designated zones. Place a check-mark in the box corre-
sponding to the source to be excluded from the selected
zone. For example, in Figure 30 Source 7 has been
excluded from Zone 4 and Zone 5.

Project Options: Paging (see Figure 31)

NOTE: THE PAGING PROJECT OPTIONS WILL ONLY FUNCTION

IF THE SYSTEM INCLUDES A DPC100 DOORBELL/PAGING

MODULE.

ENABLED: Select to enable the MRC88 paging function.

CONTROL SOURCE: Select the source whose Sense
connection you want to act as the trigger for paging.

SWITCH TYPE: Select triggering from an audio signal or a
video signal.

PAGE DURATION: Lets you select a specific time that the
system will remain in the paging mode before returning to
normal operation. You can also have the paging time be
determined by the control source.

A/V SOURCE: Select the source of the paging signal.

Figure 30: The Project Options Controller window.

Figure 31: The Project Options Paging window.
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ZONE ACTION CONFIGURATION: Determines how each zone will react when the MRC88 receives a paging control
signal:

• NONE: The zone will take no action

• MUTE ONLY: The zone will mute, but will not play the paging A/V signal.

• WHEN ON: The zone will play the paging A/V signal only if it is already ON.

• ALWAYS: The zone will play the paging A/V signal
regardless of whether it is already ON or if it is OFF. 

Project Options: Zone Linking (see Figure 32)

Zones in the MRC88 System can be linked together to
allow any combination of zones to behave as a single
zone with regard to power (ON/OFF) and source
selection. For example, if Zones 1 and 2 are linked,
when either is turned ON or OFF, both will turn ON or
OFF simultaneously. Source selections and source
content will be identical in both zones.  Volume and
Muting can still be individually controlled in each of the
linked zones.

The  Project Options Zone Linking screen allows you
to link zones statically (always linked) and dynamical-
ly (linked via a macro command). In the example
shown in Figure 32, Zones 1 and 2 are statically linked
while Zones 7 and 8 are dynamically linked.

For complete information on MRC88 zone linking, see
the Zone Linking Programming section of the MRC88
Installation Instructions.

Project Options: Zone (see Figure 33)

ZONE NAME: Lets you assign a name to each zone for
easier planning and programming.

GROUP CODE: Sets the outgoing Bank Tracking Group
Code (the default code is A8). See Project Options
Bank Tracking, on page 6.

PREAMP VOLUME SETTINGS: Variable links the zone’s
preamp output volume to the zone’s speaker level set-
ting. Fixed fixes the zone’s preamp output volume at
line-level (0dB attenuation). Sub-Zone allows the zone’s
preamp output volume to be controlled by a sub-zone
keypad that is designated in the screen’s Sub-Zone
Keypad Address box.

IR LOOP BACK SETTINGS ENABLED: Enables the 
in-zone IR emitter output located on the back of the
MRC88 keypad. When enabled, IR signals received by
the keypad’s IR receiver as well as any IR signals from
any keypad that are routed to the zone will be sent to
the in-zone emitter output.

Figure 32: The Project Options Linking window.

Figure 33: The Project Options Zone window.
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Project Options: De-bounce (see Figure 34)

De-bounce is the amount of time switches and relays need to stabilize. The De-bounce window lets you adjust the
de-bounce time individually for each of the MRC88’s eight Sense inputs. The factory default setting of ‘3’ should be
tried first. For a faster switch, try the ‘1’ setting. For slower switches change as needed to allow the controller to
sense the switch or relay condition.

Project Options: RS-232 (see Figure 35)

Establishes the RS-232 settings for the MRC88’s Com Port
and Expansion Port, as well as settings for using a 
connected RS2321X8 RS-232 router.

PROCESS RS232 INPUT: Enable this setting when the
MRC88’s RS232 port will be used to receive data to control
the MRC88 System from a PC or other RS232 device. If the
RS232 port will only be used to control external devices from
its keypad controllers, disable this setting to prevent the
MRC88 system from misinterpreting erroneous data.

Project Options: Source Components (see Figure 36)

Enables settings between the MRC88 and several specific
source components: the Xantech XDT Dual Tuner, the
Xantech XMUSICWP Music Server, the Sonance iPort®

iPod®/iPhone® docking system and the Xantech XIS100 iPod
Integration Dock.

Figure 34: The Project Options De-bounce window. Figure 35: The Project Options RS-232 window.

Figure 36: The Project Options Source Components window.
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BASE-UNIT SPECIFIC EXAMPLES
XTR39
The XTR39 offers operational sophistication and flexibility similar to the Smartpad LCD family of in-wall 
controllers in a hand-held unit. The XTR39 programming screen begins as a blank screen workspace (see 
Figure 37).  Each of the system’s components will need to have its own LCD control screen with its own 
particular set of control buttons. Normally, each of these screens would have to be  created from scratch, with
each button selected and positioned individually — a very time-consuming process. This process can be
streamlined by using Universal Dragon’s AutoBuild Wizard (see below). In addition to the touch screen, the
XTR39 has programmable hard-key function buttons programmable hard-key cursor buttons.

AutoBuild Wizard

Universal Dragon includes an AutoBuild Wizard (File > AudoBuild Wizard) that streamlines the process of 
creating individual XTR39 component control screens (see Figure 38). AutoBuild Wizard creates complete
component control screens (including some basic macros) in just a few steps. This can save you a great deal
of programming time, while still providing you with the ability to customize each screen with the particular 
buttons and macros required by the customer’s specific desires and the installation’s specific requirements.

XTR39 Programming

After selecting the XTR39 with the New Project function (File > New Project > Handhelds > XTR39), an empty
XRT39 unit workspace appears (see Figure 37). You can re-size this unit as necessary by dragging its lower
right-hand corner.

PROGRAMMING XTR39 HARD-KEY BUTTONS: The XTR39’s hard-key buttons can be programmed with different
functions for each source component.

We recommend programming any functions that will be used on all screens (such as the audio system 
volume and mute) into the XTR39’s hard-key buttons for each source, so they will be accessible no matter
what control screen is active.

SELECTING AND PROGRAMMING XTR39 TOUCHSCREEN ELEMENTS: The XTR39 provides graphic elements for the
screen’s background, and Graphical Touch Links (GTLs) that serve as source buttons and function buttons.

1. Select the Graphics Pallete tab to activate the Graphic palette window (see Figure 39, on page 20).

2.  The Styles drop-down menu contains different sets of backgrounds and source, function and image 
buttons.

3. Select a style, then click on the Backgrounds tab, choose a background and drop it into the empty XTR39
screen.

NOTE: UNIVERSAL DRAGON ALLOWWS YOU TO COMBINE BACKGROUNDS, SOURCE BUTTONS, AND FUNCTION BUTTONS

FROM DIFFERENT STYLES.

4. Click on the Home Layer icon to activate the home page, then select the Source Graphic Elements Tab (see
Figure 39, on page 20). Drop the desired Source buttons (one for each device to be controlled) onto the

Figure 37: The XTR39 Screen Workspace (empty) Figure 38: XTR39 DVD Control Screen Created with AutoBuild Wizard
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home layer (make sure that you’re on the home layer before adding each Source button). You can program their
macros (as described in Build Macros, on pages 4 – 5) now, or at a later time.

NOTE: TO HELP WITH POSITIONING ELEMENTS, THE XTR39 SCREEN WORKSPACE HAS AN ALIGNMENT GRID (ALONG WITH

A “SNAP-TO” FUNCTION) THAT CAN BE TURNED ON AND OFF. EACH GTL HAS A BORDER (SHOWN AND HIDDEN BY THE

SHOW BORDERS BUTTON) THAT SHOWS THE GTL PLACEMENT RELATIVE TO THE GRID. (SEE FIGURE 39.) ONCE ALL GTLS

ARE IN PLACE YOU CAN CLICK ON THE LOCK GRAPHICS ICON TO PREVENT ACCIDENTAL MOVEMENT OF THE GTLS.

5. Once all of the Source buttons are in place, double-click on one and then select the Functions Graphic Elements
Tab (see Figure 39). Drop the desired Function buttons for that source component onto the screen. You can 
program each button’s macro (as described in Build Macros, on pages 4 – 5) now, or at a later time.

6. Click on the Home Layer button, and repeat Step 5 for each Source button in the project.

CREATING CUSTOM XTR39 BUTTONS: The XTR39 lets you create text on blank Source and Function buttons (buttons
that contain text or graphic elements cannot be edited). This lets you create customized buttons for sources and
functions that are not included in the library by dragging and dropping blank buttons on screens and then labeling
them.

Home
Layer

Show
Borders

Show
Grid

Snap
to Grid

Grid
Size

Lock
Graphics

Show Macro
Symbol

Grid
Color

Styles
Drop-Down

Menu

Graphic
Element

Tabs

Selected
Button

Graphic
Selected
Button

Graphics Palette Tab XTR39 Workspace Properties Tab

Figure 39: XTR39 Programming Screen
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1. Click on the Properties tab. The Edit/
Graphics window will appear (Figure 40),
showing the currently-selected button.

2. Click the cursor in the caption window
and type the text you want to appear on
the selected button. After typing the text,
click the cursor outside of the caption
window and the text will appear in the
button example (see Figure 41). 

3. Use the font selector and text color
selector to change the font style and
size and text color of the button text in
the button example (see Figure 41).

3. When you’re finished formatting the text,
click on the Apply button. The text will be
applied to the selected button (see 
Figure 42).

BANK TRACKING: Each Source button can 
be assigned a unique Bank number for 
bank tracking during RC68 operation (see
Figure 42).

1. Click the cursor in the Bank Tracking Selector.

2. Use the drop-down list to select the Bank number.

3. Click on the Apply button to apply the Bank Tracking number to the selected Source button.

Properties Tab

Edit/Graphics Window

Currently-Selected Button

Figure 40: The Edit/Graphics Window

DirecTV

DirecTV

Caption
Window

Button
Example

Font
Selector

Text Color
Selector

Apply
Button

Figure 41: Edit/Graphics Window Text Tools

Selected Button
with New Text

Applied

Bank Tracking
Selector

Apply Button

Figure 42: New Text Applied to Selected Button; Bank Tracking Selector
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NOTE: SEE PROJECT OPTIONS BANK TRACKING,
ON PAGE 6.

Project Options

BANK TRACKING (see Figure 43, left): Sets the
outgoing Bank Tracking Group Code (the
default code is D8). See Project Options Bank
Tracking, on page 6.

RF2IR MODULE (see Figure 43, right): If you are
using multiple XTR39/RF2IR controllers you
will need to assign a unique network ID 
(1 ~ 254) to each RF2IR module. (ID #255
communicates with all modules.) You can also
assign a name to each module and adjust its
RS232 settings. Use the Transfer Configuration
button to send the settings to the RF2IR mod-
ule via the XTR39.

INTERNAL COMMANDS (see Figure 44): The
XTR39 lets you insert the following internal
commands into macros: Set Backlight ON/OFF,
Brightness Step UP/Step DOWN, Contrast
Step UP/Step DOWN, Audio Feedback
ON/OFF (the XTR39 will emit an audible beep
each time a button is touched), Motion Detect
ON/OFF (the backlight will automatically turn
ON whenever the XTR39 is picked-up or
moved), Start Screen Calibration/Test Screen
Calibration (enables you to create a calibration
screen for the XTR39’s touchscreen),
Increase/ Decrease RF Channel.

To add an Internal Command to an XTR39
macro (see Figure 44):

1. Click on the Internal Command tab.

2. Select the desired internal command and
state with the Internal Command Selector.

3. Select the button on the XTR39 to which you
want to apply the macro command.

4. Click on the Accept button.

The internal command will appear in the Macro
Window.

Figure 43: XTR 39 Project Options Bank Tracking (left); RF2IR Module (right)

Internal Commands TabAccept ButtonSelected Button

Internal Command SelectorInternal Command Inserted Into Macro

Figure 44: Adding an Internal Command to an XTR39 Macro
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Macro Command Properties

You can convert individual macro commands from IR to RF when the
RF2IR module is being used:

1. Right-click on the command in the macro window. The Properties
window will appear (Figure 45).

2. Set the output type for the command to RF.

3. Select the network ID for the particular RF2IR module that you want
to output the command. ID# 255 communicates with all connected
RF2IR modules.

4. Select the individual RF2IR IR emitter ports that you want to emit the
command. 

Global IR Properties

You can also convert entire existing XTR39 projects to work with the
RF2IR module without having to modify every command in the project. 
The Global IR Properties button (available when the Command List tab
is selected) displays the Global IR Properties window (Figure 46).

EXISTING RF COMMANDS: This tells RF/IR converters what to do with
commands that are already programmed as RF. Selecting the Change
Network ID Only box changes the network ID portion of existing RF
commands (see RF2IR Module, below) while leaving the command
portion of the output as programmed. Leaving the box unchecked
changes the network ID and converts the command output to the
selected type.

NOTE: THE EXISTING RF COMMANDS BOX ONLY APPLIES WHEN THE

COMMAND OUTPUT TYPE IS SET TO RF (SEE BELOW).

COMMAND OUTPUT TYPE: Select RF. (Note: You can also convert entire
XTR39 RF projects to IR, by selecting IR.)

RF2IR MODULE: Select the particular RF2IR module that you want to
communicate with. There are 254 individual module IDs; #255 commu-
nicates with all modules. Then select the particular RF2IR emitter 
output that you want to send the command. 

Figure 46: The Global IR Properties
window.

Figure 45: The IR command Properties
window.
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BASE-UNIT SPECIFIC EXAMPLES
URC2
Programming Macros 

Universal Dragon can be used to program macros on any URC2 button. URC2 button macros are programmed using
the basic steps described in Build Macros, on pages 4 – 5.

Tiers

When programming the URC2 with Universal Dragon, each source and function button can be programmed in two
‘tiers’. This allows each button to execute two completely different macros — one by pressing the 
button for less than one second, and another by pressing and holding the button for more than one second.

Use the Tier Selector in the URC2 programming window
(Figure 47) to select the Tier. When programming in Tier
1, selected buttons show on the programming screen in
blue; when programming in Tier 2, selected buttons show
on the programming screen in red. See Figure 48.
Programming is the same in both tiers. 

Internal Commands (see Figure 49)

You can insert the command for the URC2 to switch to
either Tier 1 or Tier 2 operation into a macro. 

1. Select the Tier you want the URC2 to shift to.

2. Select the button you want to program with the 
command.

3. Click the Accept button. The command will appear in
the Macro Window.

Tier
Selector

Figure 47: URC2 Tier selector Figure 48: Tier 1 selected (left); Tier 2 selected (right)

Figure 49: The URC2 Internal Commands window



25

P
r
o
g
r
a
m

m
in

g
 S

o
ft

w
a
r
e

UNIVERSAL DRAGON 2.3

BASE-UNIT SPECIFIC EXAMPLES
590-10

Programming Macros 

Universal Dragon can be used to program macros on any of the 590-10’s sixteen inputs. 590-10 input macros
are programmed using the basic programming steps described in Build Macros, on pages 4 – 5. 

NOTE: THE 590-10 HAS NO PROJECT OPTIONS OR INTERNAL COMMANDS.

Figure 50: The 590-10 programming screen
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BASE-UNIT SPECIFIC EXAMPLES
MAC1

Programming Macros 

Universal Dragon can be used to program macros that will be triggered by any of
the MAC1 remote’s 36 buttons. (These macros can also be triggered by the 
corresponding 36 buttons on an RC68+ Programmer/Remote Control unit.) MAC1
macros are programmed using the basic steps described in Build Macros, on 
pages 4 – 5.

Project Options

Group Code: The MAC1’s default group code for bank tracking is “8-0”. You can use
the Project Options screen (Figure 52) to change the group code. See Project
Options Bank Tracking, on page 6.

NOTE: THE MAC1 HAS NO INTERNAL COMMANDS.

Figure 51: The MAC1 basic programming screen

Figure 52: MAC1 Project Options
Group Code screen
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RC68 PROGRAMMING

PROGRAMMING RC68 COMMANDS IN OUTGOING MACROS

In addition to IR and RS232 commands, all Xantech programmable devices can also issue RC68 commands in
macros. Programming these commands is the same for all Xantech programmable devices:

1. Select the RC68 Programming
Window function tab (see 
Figure 53). An RC68 keypad is
displayed.

2. Select the button on the 
programmable device to which
you want to add the RC68 
command.

3. Select the desired RC68 
function button on the RC68 
keypad.

The command will be added to
the macro for the selected 
button on the device.

PROGRAMMING THE DEVICE 
TO RESPOND TO AN RC68 
COMMAND
The Smartpad LCD series and
MRC88/44 series of controllers
are capable of issuing macros in
response to receiving RC68
commands.

1. Select the RC68 tab
in the SPLCD or
MRC88/44 device
window. The RC68
button layout will be
displayed (see 
Figure 54).

2. Select the RC68 
button to which you
want the device to
respond.

3. Build the macro
according to the
steps described in
Build Macros, on
pages 4 – 5.

RC68 TabSelected Button

Selected RC68 CommandRC68 Command Inserted Into Macro

Figure 53: Placing RC68 commands in outgoing macros (SPLCD shown)

RC68 Tab Selected RC68 ButtonMacro in Response
to RC68 Command

Figure 54: Building a macro that responds to an RC68 command (MRC88 shown)
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IR LEARNING
The basic Universal Dragon IR learning procedure is the same
for all Xantech programmable devices that are IR-learning
capable. Read the instruction documentation for the particular
programmable device before using Universal Dragon’s IR
learning procedure.

1. Select the Palette Editor tab to display the Palette Editor
window (see Figure 55).

2. Change the Palette Editor mode to Edit.

3. Use the Learning Device selector to select the particular 
programmable device that you are using.

4. Be sure Test and Show IR Library are not selected.

5. Scroll the IR Library and click the ‘+’ next to the brand of
remote you are learning from. A sub-directory of compo-
nents will appear. If the desired brand does not appear on
the list you can create it:

a) Click the Add menu and select Brand, or right-click 
anywhere in the brands list and select New Brand in the
pop-up.

b) A text box [New Brand] will appear at the bottom of the
brands List. Type the name of the new brand and press
Enter on the keyboard.

c) The new brand name is added to the list and saved.

NOTE: THE NEW BRAND WILL ULTIMATELY BE SAVED TO THE IR
LIBRARY BRANDS LIST ALPHABETICALLY, BUT WILL NOT APPEAR AS

AN IR LIBRARY BRAND UNTIL AT LEAST ONE COMPONENT AND ONE

FUNCTION HAVE BEEN PROGRAMMED TO IT. TO FIND A NEW BRAND

THAT DOES NOT HAVE ANY COMMANDS PROGRAMMED, CHANGE THE

PALETTE EDITOR MODE TO EDIT AND SCROLL THE LIST TO THE

NEW BRAND.

6. Click the ‘+’ next to the brand you are learning from. If the required
component does not appear in the sub-directory, you can create it: 

a) In the brands list, select the brand to which you’re adding the new
component.

b) Click the Add menu and select Component, or right click the
selected brand then select Add Component in the pop-up.

c) A text box [New Component] will appear at the bottom of the
selected brand’s components sub-directory. Type the name of the
new component and press Enter on the keyboard.

7. A function list for the selected component will appear (see 
Figure 56). Review the function list and compare it to the source
remote. If a particular function is not displayed or not named 
appropriately, you can add it:

a) Right-click in the Command Window and select Add Command
from the pop-up.

b) Type the name of the new command and press Enter on the key-
board. The new command will be saved to the Command List and
will be available for programming HEX, RS232 or IR commands
for that specific brand and component.

Mode
Selector

Palette Editor 
Tab

New Brand in
IR Library

Learning Device
Selector

Add Brand/Component
Selector

Figure 55: Palette Editor window in learning mode

Command
Window

New Component
in IR Library

Function
List

Figure 56: New component with un-learned
commands
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8.  Click REC at the top of the Palette Editor. It will
highlight to indicate that Universal Dragon is in the
record mode. 

IMPORTANT: BEFORE PROCEEDING, READ STEPS

9 – 12, AS THE RECORD PROCESS IS A TIMED FUNCTION.
THE AMOUNT OF TIME YOU WILL HAVE IS DEPENDENT ON

THE PARTICULAR XANTECH DEVICE YOU ARE USING.

9.  Place the teaching (source) remote in the optimal 
position relative to the Xantech device.

10. In the Function List, select the command to be
learned (i.e. Power, Play, Stop etc.). The Learn IR
window will appear. You will have a certain number
of seconds (dependent on the Xantech device) to
learn the IR command.

11. Perform the learning procedure as outlined in the
manual for the specific Xantech device. When the
message IR Learning Was Successful appears,
click OK. An XIR1 or XIR2 symbol will appear to
the left of the selected function, indicating that an
IR code has been successfully learned (see
Figure 57).

NOTE 1: IF YOU WAIT LONGER THAN THE ALLOTTED TIME,
A TIME-OUT MESSAGE: ‘FAILED TO LEARN IR TIMEOUT’
WILL APPEAR. CLICK OK AND TRY AGAIN. IF YOU

CONTINUE TO HAVE PROBLEMS LEARNING COMMANDS,
RUN A ‘WHO AM I’ TO CONFIRM PC CONNECTION TO AND

COMMUNICATION WITH THE XANTECH DEVICE.

NOTE 2: WHEN TEACHING COMMANDS, PRESS-AND-HOLD THE BUTTON UNTIL THE ‘IR LEARNING WAS SUCCESSFUL’
MESSAGE APPEARS. NOT ALL IR CODES ARE STRUCTURED THE SAME. SOME WILL BE LEARNED WITH A PRESS-AND-HOLD

WHILE OTHERS MAY REQUIRE A QUICK TAP OF THE TEACHING REMOTE BUTTON. SOME WILL REQUIRE A BUTTON PRESS

DURATION SOMEWHERE IN BETWEEN.

12. Repeat Steps 9 – 12 for all command functions for your project that are not found in the IR Library.

13. All learned commands can now be utilized for programming: Change the Palette Editor mode to Palette,
select Show IR Library and navigate the brand/component list to the learned commands.

Figure 57: XIR2 Play command successfully learned
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TRANSFERRING PROGRAM INFO
VERIFYING COMMUNICATION
The easiest way to verify that Universal Dragon can communicate with
the programmable device is by performing a Who Am I procedure.

1. Connect the device to your computer and verify that it is receiving
power and is turned ON.

2. In the Base Unit menu,
select Who Am I.

3. Select the device that
you are programming
from the drop-down
menu (see Figure 58).

If the proper driver for
the device is installed
and Universal Dragon
recognizes the com port
the device is connected
to, Universal Dragon will
display the dialog box
shown in Figure 59. You
can then transfer the
project to the device (see
Transferring The Project, below.) 

If Universal Dragon does not recognize the com port or the device, it
will display the dialog box shown in Figure 60. If it does not recognize
the com port, Universal Dragon may also display the dialog box
shown in Figure 61 when attempting to transfer a project.

INSTALLING DEVICE DRIVERS
If Universal Dragon displays the dialog box shown in Figure 59 during
a Who Am I query, or the dialog box shown in Figure 60 when
attempting to transfer a project, you wil need to install the device’s
driver into your computer’s operating system. 

1. When you first connect the device to your computer Windows will display the Found New Hardware Wizard (see
Figure 62). Select No, not this time and click Next.

2. On the next screen that is displayed (Figure 63), select Install from a list or specific location (Advanced).
The Browse for Folder dialog box will be displayed.

Figure 61: Error syncing with device screen

Figure 58: Who Am I drop-down menu

Figure 60: Who Am I with device not recognizedFigure 59: Who Am I with device recognized

Figure 63: Found New Hardware Wizard screen #2Figure 62: Found New Hardware Wizard screen #1
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3. Navigate to the following folder: C: (or Local Disk) > Program Files
folder > Xantech folder > Universal DragonvXX.X folder > Drivers
folder (see Figure 64).

4. With the Drivers folder selected, select OK. Windows will find and
install the correct driver for the device. 

SELECTING THE PROPER COM PORT
After you have installed the device’s driver into your computer’s system,
if Universal Dragon still displays either of the dialog boxes shown in
Figure 59 or Figure 60 you may need to tell Universal Dragon to which
com port the device is connected.

1. On your computer’s desktop, right-click on the My Computer icon
and select Manage. The Computer Management dialog box will be
displayed (Figure 65).

2. Double-click Device Manager. The Device Manager screen will be
displayed (Figure 66). The port to which the device is connected
will be listed
under Ports. Note
the port number. 

3. In the File menu,
select Global
Preferences. The
Preferences box
(Figure 67) will
be displayed.

4. In the Serial
section, use the
Available Ports
drop-down menu
to select the port
number shown in
the Device
Manager screen (Step 2).

OBTAINING ADDITIONAL INFORMATION
UNIVERSAL DRAGON SOFTWARE UPDATES: http://xantech.com/
Downloads/Software/. This page also contains links to various 
support documents that can help when using Universal Dragon to
program Xantech devices. 

NOTE: THE LATEST VERSION OF UNIVERSAL DRAGON AT THE TIME OF

WRITING OF THIS MANUAL IS V2.3.25.

FIRMWARE UPDATES:http://xantech.com/Downloads/Firmware/.

APPLICATION ADVISORIES: http://xantech.com/Downloads/AppAdvisories/.

INSTRUCTION MANUALS AND QUICK-START GUIDES: www.xantech.com.
Use the Product Manuals drop-down list near the bottom of the page.

TRAINING MODULES: http://www.xantech.com/News/Training/

FAQS: http://www.xantech.com/FAQ/

FORUM: http://www.xantechforum.com/forum/YaBB.pl. After registering and receiving your confirmation e-mail,
go to Dragon’s Lair.

SUPPORT DOCUMENTATION FOR OTHER XANTECH PRODUCTS: http://www.xantech.com/Support/

Figure 64: Universal Dragon Drivers folder

Figure 66: Device Manager screen

Figure 67: Global Preferences screen

Figure 65: Computer Management screen
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